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Bien débuter une recherche d’information

¨ Formuler une question de recherche précise

¤ Exemple : Quelle est la qualité de vie des patients traités par 

radiothérapie pour un cancer du larynx ?

n Préciser tous les éléments de la question

n Décomposer la question en critères (mots clés) les plus précis 

possibles

n Placer ces mots clés dans une grille PICO

¨ Utiliser le langage contrôlé pour interroger Medline
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Critères Mots clés

P Problème qui se pose, Pathologie, Population ou 

Patients étudiés
(Age ? Sexe ? Maladie ? Facteurs de risque ? Etc.)

I/E Intervention envisagée, Exposition à ?
(Traitement ? Dosage ? Exposition ? Durée ?)

C Comparaison avec une autre intervention
(Placebo ? Gold standard ? Absence de traitement ?)

O Objectifs visés et critères d’évaluation
(Critères objectifs mesurés pour démontrer l'efficacité de I/E)

3

Grille PICO
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Pourquoi faire un PICO ?...

¨ Permet de préciser au mieux la question

¨ Décompose la question en recherches séparées 

¤ P, I/E, C, O = 4 recherches

¤ Moins de risques d'erreurs

¨ Augmente les chances de trouver des articles pertinents
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¨ Quelle est la qualité de vie des patients traités par
radiothérapie pour un cancer du larynx ?

Equation de recherche finale : 1 AND 2 [AND 3]

Critère Mots clés Recherche

P Cancer du larynx N�1
I/E Radiothérapie N�2
C / /
O Qualité de vie N�3

5

Exemple : marche à suivre
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Medline
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¨ Interface Pubmed, bases de données :

¤ Medline, Pubmed Central

¤ BD factuelles de biologie moléculaire : OMIM, GenBak, Genome, Protein, 

Structure, Taxonomy

¨ Produite par la National Library of Medicine (NLM)

¨ Plus de 5600 périodiques depuis 1946

¨ Plus de 27 millions de notices d'articles scientifiques

¨ Sciences biomédicales, médicales, biologiques,…

¨ Mise à jour quotidienne
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PubMed : le moteur de recherche
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¨ Portail créé par la NLM (http://www.ncbi.nlm.nih.gov/pubmed)

¨ Moteur de recherche conçu spécialement pour chercher dans 

Medline

¨ Recherche simple (Search box sur la page d'accueil)

¨ Recherche avancée (lien Advanced)

¨ Accès gratuit



GETTEC 2018

Frédéric de Lemos Esteves

Dialogue avec le moteur de recherche
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1. Langage naturel : mots clés (keywords)

¤ Vocabulaire utilisé par les auteurs

2. Langage contrôlé :  descripteurs (subject headings)

¤ Thésaurus propre à chaque base de données quand celle-ci en 

propose un (Medline = MeSH)

¤ Vocabulaire utilisé par les concepteurs des bases de données

¤ Description du contenu de l'article
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Rechercher en langage naturel = prendre des risques
Résultats très variables en quantité et en qualité en 

fonction du mot clé 

1. Langage naturel (mots clés)
9

¨ Avantage : précision

¤ Si le mot clé n'a qu'une seule signification

¤ Si la recherche est limitée à un seul champ

¨ Désavantage : bruit de fond

¤ Si le mot clé peut apparaitre dans différents contextes

¨ Envisager tous les synonymes

¨ Envisager toutes les formes grammaticales

¤ Masculin / féminin ; Singulier / pluriel *

¨ Envisager toutes les orthographes

¤ Anglais USA/ anglais UK *

* Certaines interfaces envisagent les différentes formes (ex: Pubmed)

Exemple : "cancer du larynx"
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Mots clés Références (n)

Cancer of larynx[Title/Abstract] 86

Larynx cancer[Title/Abstract] 779

Larynx neoplasms[Title/Abstract] 1 450

Recherche de mots clés dans le titre et le résumé
(22/03/2018)

Rechercher par mots clés = prendre des risques

Résultats très variables en quantité & qualité selon le mot clé choisi

Risques de la recherche par mots clés
10
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Pubmed et le bruit de fond
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¨ Recherche des mots clés sans tenir compte de leur 
contexte (faiblesse du langage naturel)

¤ Eclatement des expressions composées de plusieurs termes  >>> 
perte de sens

¨ Recherche des mots clés dans tous les champs au lieu de 
se limiter au titre et au résumé 
(pas de pondération en fonction du champ concerné)

¨ En pratiquant l'explosion systématique des descripteurs 
MeSH >>> recherche hors sujet
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"laryngeal neoplasms"[MeSH Terms] OR ("laryngeal"[All Fields] AND "neoplasms"[All
Fields]) OR "laryngeal neoplasms"[All Fields] OR ("larynx"[All Fields] AND "cancer"[All
Fields]) OR "larynx cancer"[All Fields]

Contrôler Pubmed

¨ Lors d’une recherche dans Medline via Pubmed, il faut avoir en tête

que Pubmed:

¤ Privilégie l’exhaustivité (explosion du descripteur par défaut)

¤ Construit une stratégie de recherche à partir du langage naturel proposé par

l’utilisateur (vérifier Search details)

¤ Décompose les expressions composées de plusieurs termes

¨ Exemple de requête: Larynx cancer

12
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¨ A partir de la fenêtre Search

Details, il est possible de :

¤ Modifier l'équation de 

recherche pour augmenter la 

précision des résultats

¤ Relancer la recherche en 

appliquant l'équation modifiée

Corrigez les requêtes incorrectes
13

"laryngeal neoplasms"[MeSH Terms] OR
("laryngeal"[All Fields] AND "neoplasms"[All
Fields]) OR "laryngeal neoplasms"[All Fields]
OR ("larynx"[All Fields] AND "cancer"[All
Fields]) OR "larynx cancer"[All Fields]
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2. Langage contrôlé : descripteurs
14

¨ Expressions UNIQUES utilisées pour décrire chacune des 

notions abordées dans les articles

¨ Thésaurus propres à chaque BD

n Descripteurs MeSH dans Medline

n Descripteurs APA dans PsycInfo

n Descripteurs Emtree dans Embase

¨ Ajoutées sur chacune des notices par indexation
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Indexation des notices (Medline)
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¨ Numéro unique d'identification dans la BD (PMID)

¨ Auteurs de l'article (Authors)

¨ Titre de l'article (Title)

¨ Référence de l'article dans le périodique (Source)

¨ Résumé de l'article (Abstract)

¨ Descripteurs médicaux (MeSH Terms)

¤ L'indexation est un travail qui consiste à ajouter des 

descripteurs sur chacune des notices

¤ Ces descripteurs décrivent le contenu d’un article

¤ L’indexation prend du temps et les notices les plus 

récentes ne sont pas encore indexées
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Arrivée du périodique

Dépouillement des articles

Encodage des citations et des abstracts

NLM

Editeurs

In Process 

Indexation
Ajout des descripteurs MeSH aux notices

Medline

[PubMed - in process]
[PubMed - as supplied by publisher]

[PubMed - indexed for Medline]

Statuts des notices dans PubMed
16
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Langage contrôlé
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Exemple : "cancer du larynx"
¨ Un seul descripteur 

présent sur chacune des 

notices (Medline) parlant du 

cancer du larynx :

"Laryngeal Neoplasms"[MeSH]

Rechercher en langage contrôlé = meilleur compromis entre précision et sensibilité
(toujours utiliser le descripteur le plus précis possible)
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Recherche en 
langage naturel

Recherche en 
langage contrôlé

18

Champs de recherche
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Force du langage contrôlé

¨ Meilleur équilibre possible entre :

¤ Exhaustivité

n Trouver (presque) tout ce qui est publié sur un sujet (>85%)

¤ Bruit de fond

n Limiter la pollution des résultats par des références non 

pertinentes

19
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¨ Recherches par mot clé (dans l’intégralité des notices) ou

recherche par descripteur (dans le champ des MeSH Terms)
(22/03/2018)

Mots clés Références (n)

Cancer of larynx[Title/Abstract] 86

Larynx cancer[Title/Abstract] 779

Larynx neoplasms[Title/Abstract] 1 450

"Laryngeal Neoplasms"[Mesh] 26 244

Exhaustivité maximale à partir d'un seul descripteur MeSH

Comparaison des résultats obtenus
20
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Interroger la MeSH Database

Partir de la notice 
d’un article 

pertinent connu

(Ou/Et)

Où trouver les descripteurs MeSH ?
21
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1. Rechercher le descripteur MeSH correspondant à un 
mot clé du PICO. Exemple : laryngeal cancer

10 étapes en pratique
22
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2. Choisir le descripteur MeSH pertinent

10 étapes en pratique
23
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3. Toujours lire la définition du descripteur MeSH
24

10 étapes en pratique
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4. Préciser en ajoutant un sous-descripteur ?

5. Add to search builder
6. Search Pubmed

10 étapes en pratique
25
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7. Parcourir les résultats de la première recherche

TOUJOURS Vérifier l'équation de recherche dans la fenetre Search details !

10 étapes en pratique
26
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8. Recommencer avec le I, (le C) et le O
9. Combiner les recherches (and, or, not)

1

2

3

4

10 étapes en pratique
27
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10. Appliquer les filtres le cas échéant

• Type d'article/étude (RCT, SR, MA …)
• Accès au texte intégral (free full text, …)
• Date et langue des publications
• Espèce (humans, …)
• Age et sexe des patients
• …

10 étapes en pratique
28
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¨ Permet de gérer les résultats

• Enregistrer dans un fichier (File)
• Partager par e-mail (E-mail)
• Sauvegarder dans un dossier temporaire 

(Clipboard)
• Sauvegarder de façon permanente dans 

MyNCBI
(My Bibliography) 

• Exporter vers un logiciel personnel de gestion 
de bibliographies de type EndNote, Zotero, 
Mendeley, etc. (Citation Manager)

Outils Send To
29
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Sign in to My NCBI

¨ Compte personnel (My NCBI ) sur PubMed

¨ Permet de :

¤ Sauvegarder des références et gérer des listes de résultats

¤ Sauvegarder des stratégies de recherche

¤ Créer des alertes permettant de relancer une recherche à 

intervalles réguliers

¤ Personnaliser l'affichage des filtres
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My NCBI
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Dr Frédéric de Lemos Esteves 
fdelemosesteves@uliege.be

Merci pour votre attention !
Des questions ?
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MENDELEY : LOGICIEL DE GESTION DE 
RÉFÉRENCES BIBLIOGRAPHIQUES (LGRB)
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¨ Quantité d’informations à gérer, informatisation

¨ Capitaliser tout au long d’un travail

¨ Organisation et partage de références

¨ Nombreux styles différents, normes

¨ Commenter, annoter, collaborer

¨ Citer dans le texte, générer une bibliographie

34

Pq utiliser un LGRB ?
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Mendeley

¨ Logiciel gratuit de Gestion de Références Bibliographiques 

(LGRB ou LGB) avec PDFs associés 

¨ Génère des bibliographies dans des documents word

¨ Windows, Mac ou Linux et tous navigateurs

¨ Application gratuite smartphone et tablette

¨ Versions installée et en ligne indissociables et synchronisables

35
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Stockage
36

¨ Gratuité limitée :
n Stockage en ligne jusqu’à 2 Go
n Forfait équipe en fonction du nombre de collaborateurs
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Commencer avec Mendeley

1. Créer son compte en ligne sur le site de Mendeley avant 
l’installation de l’interface en local (https://www.mendeley.com)

37
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Commencer avec Mendeley

2. Installer en local Mendeley Desktop

38
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¨ Mendeley (dans le cloud)
¤ Literature Search : recherche dans le catalogue Mendeley

¤ Mendeley Suggest : notices suggérées par Mendeley

¨ My Library (en local)

¤ All Documents : tous les documents

¤ Recently Added : notices ajoutées au cours des 14 derniers 
jours

¤ Needs Review : notices incomplètes

¤ My Publications : références dont vous êtes l'auteur

¤ Unsorted : références orphelines

39

Gestion des références
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¨ Folders: créer (ou supprimer) des dossiers dans le desktop

¨ Related: trouver des références en lien avec l'article

sélectionné

¨ Sync: synchronisation avec la version web

Gestion des dossiers
40
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¨ Edit Settings -> choix des dossiers à synchroniser
¤ Permet d'économiser de la place de stockage si besoin

Paramètres de synchronisation
41
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¨ Add Files (ou glisser-déposer) : ajout de fichiers à partir du HDD (ris, bib ou pdf)

¨ Folders : ajout de dossiers et de l’ensemble des documents qui s’y trouvent

¨ Watch Folder : dossier dans lequel tout document est importé dans votre base de données

Les métadonnées du pdf sont automatiquement récupérées par Mendeley mais :

¤ Vérifier si les champs sont exacts et complets

¤ Ne fonctionne pas avec les documents numérisés au format pdf

42

Alimenter sa base de données
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¨ Add Entry Manually : 

¤ Encodage manuel d’une référence. Attention "needs review " = référence incomplète

n 20 types de documents 

n 67 champs de métadonnées

¤ Import à partir du DOI ou PMID : création de la notice et bonification des 
métadonnées

1

2
3

43

Alimenter sa base de données
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¨ Par défaut, toutes vos références sont partagées dans le 
cloud (!)

Vous pouvez décider d'exclure 
une référence de la base de 
données partagée en cochant 
Unpublished work

Cloud Mendeley
44
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¨ Importation de notices à partir de BD et de 
catalogues compatibles avec Mendeley.

¨ Installer « web importer »
¤ Mendeley Desktop : Tools -> Install web importer

45

Web importer
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¨ Cliquer sur l’icône     dans la barre de menu

• Un volet s’ouvre, les références sont prêtes 
à être insérées dans Mendeley Web, soit 
toutes ensemble avec « Save All », soit sur 
sélection.

• La synchronisation à partir de Mendeley 
Desktop importe la notice en local

46

Web importer
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¨ Édition de la notice avant importation

Cliquer sur "détails" pour éditer la notice et y 
apporter des modifications

47

Web importer
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¨ Modification(s) de la notice avant importation

Tags

48

Web importer
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1. Cliquer sur l'icône Mendeley > cocher les références à importer > Save all

Importation directe depuis Pubmed
49
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1. Sélectionner les références à exporter 2. Send to

3. Enregistrer le fichier citation.nbib

Permet de conserver une copie de la 
bibliographie au format citation.nbib
avant importation

Importation indirecte depuis Pubmed
50
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4. Dans Mendeley Desktop: File > Add Files et récupérer le fichier citation.nbib

Importation indirecte depuis Pubmed
51
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¨ Joindre plusieurs documents à une seule notice
¤ Cliquer sur Add File et sélectionner le PDF à insérer

Gestion des fichiers pdf
52
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¨ Surligner et annoter des fichiers pdf

Gestion des fichiers pdf
53
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¨ Installer le plugin qui fait la liaison avec Word
¨ Tools -> Install MS Word Plugin

Créer une bibliographie avec citations
54
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1. Sélectionner l’onglet Références

2. Cliquer sur Insert Citation

3. Cliquer sur Go To Mendeley

Effectuer une recherche ciblée…

… ou ouvrir votre bibliothèque Mendeley

Word : bibliographie avec citations
55



GETTEC 2018

Frédéric de Lemos Esteves

4. Go To Mendeley :
¤ Ouverture de Mendeley

¤ Sélection de la référence

¤ Insertion de la citation dans le texte en cliquant sur Cite

Word : bibliographie avec citations
56
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5. Générer la bibliographie dans Word en cliquant sur Insert 
Bibliography

¤ Modifier le style dans Style
Harvard Vancouver

Word : bibliographie avec citations
57



GETTEC 2018

Frédéric de Lemos Esteves

¨ View -> Citation Style

Choix ou ajout de style(s)
58
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¨ Supprimer une citation : 
¤ Sélectionner la citation dans le texte -> effacer -> cliquer sur refresh

Word : bibliographie avec citations
59
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¨ Couper le lien avec Mendeley quand la bibliographie est terminée

Word : bibliographie avec citations
60
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¨ La version ouverte est modifiable tandis que la version fermée ne 
l'est plus (reconnaissable par la couleur de fond de la bibliographie)

Attention !!
Toujours sauvegarder une version ouverte 
en backup

Soumettre la version fermée à l’éditeur 
pour éviter les problèmes de non lisibilités

Word : bibliographie avec citations
61



GETTEC 2018

Dr Frédéric de Lemos Esteves 
fdelemosesteves@uliege.be

Merci pour votre attention !
Des questions ?


